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READ ME FIRST

Welcome to Take Control of Podcasting on the Mac, version 1.0.

This ebook gives you all the information you need to begin your first
podcast quickly and without spending much (if any) money. The
ebook suggests which software and hardware to buy for better results.
This ebook was written by Andy J. Williams Affleck, edited by Glenn
Fleishman, and published by TidBITS Electronic Publishing.

You can contact TidBITS Electronic Publishing by sending email to
tc-comments@tidbits.com and view the Take Control Web site and
catalog at http://www.takecontrolbooks.com/. You can read About
This Ebook to learn about the author, the publisher, and the Take
Control series. The copyright page contains copyright and legal info.

The price of this ebook is $10. If you want to share it with a friend,
please do so as you would with a physical book, meaning that if your
friend uses it regularly, your friend should buy a copy. The Help a
Friend button on the cover makes it easy for you to give your friend
a discount coupon.

We may offer free minor updates to this ebook. Click the Check for
Updates button on the cover to access a Web page that informs you
of any available or upcoming updates. On that page, you can also
sign up to be notified about updates via email.

Onscreen Reading Tips
We carefully designed the Take Control ebooks to be read onscreen,
and although most of what you need to know is obvious, note the
following for the best possible onscreen reading experience:

• Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links,
as are URLs and email addresses.

• Work with the Bookmarks tab or drawer showing so that you can
always jump to any main topic by clicking its bookmark.

• In Adobe Acrobat Pro version 6 or 7, set your preferences to view
Web URLs in a Web browser: choose Acrobat > Preferences,
switch to the Web Capture pane, and choose In Web Browser from
the Open Web Links pop-up menu.

mailto:tc-comments@tidbits.com
http://www.takecontrolbooks.com/?14@@!pt=0029-INTERNAL
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• Find more tips at
http://www.takecontrolbooks.com/faq.html#reading0.

Printing Tips
Although our layout is aimed at making online reading an enjoyable
experience, we’ve made sure that printing remains a reasonable
option. Please review these tips before you print:

• Use the Check for Updates button on the cover to make sure you
have the latest version of the ebook and to verify that we don’t plan
to release a new version shortly. If you want to commit this ebook
to paper, it makes sense to print the latest possible version.

• Don’t throw out your PDF after you print! You must click the
Check for Updates button on the cover to get future updates.
The link must be accessed from the cover of your PDF.

• For a tighter layout that uses fewer pages, check your printer
options for a 2-up feature that prints two pages on one piece of
paper. For instance, your Print dialog may have an unlabeled pop-
up menu that offers a Layout option; choose Layout, and then
choose 2 from the Pages per Sheet pop-up menu. You may also
wish to choose Single Hairline from the Border menu.

• When printing on a color inkjet printer, to avoid using a lot of
color ink (primarily on the yellow boxes we use for tips and
figures), look for an option to print entirely in black-and-white.

• In the unlikely event that Adobe Acrobat or Adobe Reader cannot
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.

Basics
In reading this ebook, you may get stuck if you don’t know certain
fundamental facts about audio settings on your Mac or if you don’t
understand Take Control syntax for things like working with menus
or finding items in the Finder. Please note the following:

• Finding an application’s preferences: I often refer to
preferences in an application that you may want to adjust. Don’t
confuse an application’s preferences with the system-wide settings
found in System Preferences. To access an application’s prefer-
ences, choose [Application Name] > Preferences from the menu

http://www.takecontrolbooks.com/faq.html#reading0
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bar. For example, in the program Audacity, choose Audacity >
Preferences. Within some applications, all preference controls
appear in a single window. In others, a bank of tabs is located
across the top. In those cases, click a tab to display a pane with
that category of preferences. Instead of providing detailed
navigation to reach application preferences each time, I use an
abbreviated notation such as “go to the Audio preference pane.”

• Menus: When I describe choosing a command from a menu in
the menu bar, I use an abbreviated description. For example, the
abbreviated description for the menu command that saves a file
from GarageBand is “File > Save.”
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 INTRODUCTION

I discovered podcasting before it had a name. In August 2004, Adam
Curry, a former MTV VJ, began producing a daily show from his home
in the Netherlands in which he talked about topics that interested him
and played music he felt like sharing. While others had produced
“audio blogs” before, Adam was the first to create a system for both
subscribing to and automatically downloading these audio shows.

I was immediately fascinated, and it was only a few months later that
I began producing my own show. I did it in part to see if I could and
because I’ve always been something of a sucker for new technologies.
My Web log has been continuously active since 1994, making it one
of the oldest out there, and I had always dreamed of making it richer.
Podcasting opened that door for me. I wrote this ebook to open the
door for you as well.

A podcast is a downloadable audio file that someone has made
available online. It could be as simple as a song they wanted to share
or it might be a full-blown audio show in the style of a radio program
that they edited together. Podcasting lets you subscribe to somebody’s
show, usually at no cost—though for-pay podcasts do exist—and have
the most recent podcasts downloaded to your computer. These fea-
tures make podcasting new and interesting compared to audio files
linked from Web sites.

An individual podcast, also known as an episode, is typically retrieved
using software, sometimes called a podcatcher, that automatically and
regularly checks for newer episodes. A podcast file is usually in MP3
format, though other audio formats can be used as well. The publish-
ing side of podcasting is syndication; the retrieval side is subscription.
Podcasts can be downloaded manually as well.

NOTE You do not need an iPod to listen to podcasts. If another MP3 player
were the cool toy everyone had to have, podcasting would have been
given a different name. Some people use the term audio blogging,
which does not encompass the variety of material found in podcasts.

Podcasting combines elements of several disparate existing
technologies—audio recording and editing, content syndication, and
Internet file transfers—into a single seamless process that retrieves
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audio from a Web site onto your computer and, usually, synchronizes
it to an external MP3 player. It can be as simple as clicking one button
to initiate this whole process.

NOTE You can read about the history and origins of podcasting as well as
the basics of subscribing and listening to podcasts in TidBITS #766
in an article I wrote entitled “Podcasting: The People’s Radio”
(http://db.tidbits.com/getbits.acgi?tbart=07986). See also my
follow-up article that details using Apple’s iTunes podcatching
features (http://db.tidbits.com/getbits.acgi?tbart=08160).

Creating your own podcasts can be highly rewarding. I enjoy pulling
together music, my writings, random thoughts, and interviews with
people into a single show. Other people create actual radio shows in
the classic style of old-time radio theater. Some use podcasting as
another outlet for their writing.

Educators and academic institutions like Stanford University and
Harvard University Graduate School of Education are beginning to
examine how podcasts can enhance learning. Major companies now
use podcasting as a way to get their content out to a much wider
audience. As you can imagine, you can find a great variety of shows.

The shows themselves certainly don’t need the professional veneer
of a commercial radio broadcast; most people opt for something with
less gloss. In fact, some podcasters feel it’s almost antithetical to the
podcasting spirit to be overly professional about it.

Just start recording and don’t worry too much about it. If your con-
tent is worthwhile, you’ll find an audience. You can always improve
your production as you get your feet wet and see what works and
what doesn’t. The key is to enjoy yourself.

http://db.tidbits.com/getbits.acgi?tbart=07986
http://db.tidbits.com/getbits.acgi?tbart=08160
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QUICK START TO PODCASTING

This ebook shows you how to create, publish, and promote your
podcast. The basic steps are Plan, Record, Edit/Encode, and Publish.
You can learn about these in any order but I encourage beginners to
read through the material in order.

Plan your podcast:

• Understand the process; see Plan Your Podcast.

Record your podcast:

• Make sure you have the hardware and software that fits your needs
and budget; see Set Up Your Studio.

• Avoid common microphone mistakes; see Use a Microphone Well.

• Record your podcast; see Record with Audio Hijack Pro, Record
with GarageBand, or Record with Audacity, or Record with
SoundStudio.

Edit and encode your podcast:

• Edit your podcast; see Edit Your Podcast with GarageBand, Edit
Your Podcast with Audacity, Edit Your Podcast with SoundStudio,
or Edit Your Podcast with Audion.

• Decide what encoding settings you want to use; see Encode Your
Podcast.

• Encode your podcast for uploading; see Encode Your Podcast
Using iTunes.

Publish and promote your podcast:

• Understand bandwidth so you don’t go broke if you become
popular; see Understand Bandwidth Costs.

• Upload and host your show in a Web log; see Tools to Publish
Podcasts.

• Syndicate your show; see Understand Syndication Formats.

• Promote your show; see Promote Your Podcast.
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PLAN YOUR PODCAST

Proper planning produces podcast prosperity.

Decide What You Want to Say
This may sound obvious, but knowing what you want to say is a
critical step, and it will inform much of what follows. Do you want
to talk politics? Music? Cooking? Just have an audio version of your
Web log? There’s no set rubric for what a podcast should and should
not be. Podcasts cover a wide range of territory.

While you are by no means required to have a single topic, it does
help if it can be summed up in a single sentence. More people will
sample your show if it fits in a category in a podcast directory—like
that found in iTunes—than if it ends up lumped in a generic catchall
list. For instance, I will listen to a podcast of the random thoughts of
a person I’ve never met only if the podcast has been strongly recom-
mended. However, I do sample non-recommended shows that
connect to an interest of mine.

Pick a Format
Decide how simple or complex you want your show to be. Do you
want a standard opening (called the intro) and closing (outtro)?
Do you want music to segue between topics much the same way
NPR’s All Things Considered does? Do you want the show to be just
you talking or will you have multiple hosts in a round-table format?
Will you interview people, either in person or over the phone or
Internet? Will you play a lot of music? Maybe your show will change
with each episode and be all these things and then some. Whatever
you decide, do realize that a fixed format will simplify producing
your show and help your audience know what to expect.

Decide on Spontaneity vs. Polish
Is it better to write a script and produce a podcast through editing
than it is to talk off the cuff and let the chips fall where they may?
This is an ongoing debate in the podcasting community. Some believe
an ad hoc show is more honest. With unscripted and unedited shows,
you have a less intermediated portrayal of who your host is and what
views he or she represents. Many people think that approach is better
than the more highly produced content found on broadcast radio.
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I think both sides of the debate are right. I look forward to podcasts
that are more professional and have higher production values (in the
lingo, they are more produced) especially in the area of “radio dramas,”
such as the Adventures of Dr. Floyd (http://www.doctorfloyd.com/).
At the same time, I never want to lose those wonderful, spontaneous
moments that arise when working without a net. I strive for a mix
of the two when producing my show.

While I am certainly not attempting professional-level production
values—I don’t have the equipment or the time for that level of effort—
I also try to maintain at least some level of quality. I tend to re-record
any major flubs, especially if it’s a technical gaffe such as sound levels
being too far off or a botched song queue. But I leave smaller gaffes
alone, and I don’t mind if my 5-year-old wanders into the room while
I’m recording.

Your audience will dictate what level of quality you will strive to
achieve. They will let you know what they like and do not like and
they will make suggestions. Also important is your own level of
involvement. You must decide for yourself.

A critical tool for improving your shows over time is to listen to a
program a few weeks after you produce it. You will be amazed at
what you notice with a little distance between yourself and a partic-
ular show. When I listen to my earliest shows again, I recoil at how
often I say “um.” My revulsion at hearing myself say “um” has helped
me stop saying that filler word.

http://www.doctorfloyd.com/
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SET UP YOUR STUDIO

The format for your podcast will determine the technical setup.
Some people want to be mobile and record as they are out and about.
However, for most people, podcast tasks are carried out sitting in
front of a single computer with a single microphone and mixing in
sounds from other applications, including iTunes, Skype, and iChat.

Choose a Microphone and Supporting Hardware
The only truly essential tools are a computer and a microphone.
A breakout box designed to provide external inputs of various kinds,
including those used in more traditional audio, may be a helpful
addition. Some podcasters find a mixer for modifying multiple sound
inputs useful as well. Let’s start with the mic, however, and see
whether your needs encompass the other two kinds of hardware.

Pick the kind of mic
For podcasting, two types of microphones are important: a direc-
tional mic, which records sound from one specific direction; and
an omnidirectional mic, which picks up sound in all directions.

• Directional: This kind of mic, sometimes called unidirectional,
filters sound from all areas except the primary direction it’s
designed for. It’s great for general speech because you can focus it
on your voice and have all other sounds, including your computer’s
fan, not be as intrusive. But for interviews, each subject or speaker
needs his or her own directional mic to have it work.

These microphones are more likely to pick up wind noise and
plosives, which are strong blasts of wind from your mouth when
you say sounds like S or P. (Plosives can be prevented by the use
of a windscreen, discussed in Use a Microphone Well.)

• Omnidirectional: An omnidirectional mic works well for pod-
casts where you are recording ambient sounds outdoors, such as
when you create a soundseeing tour. It’s also good for an interview
if you only have a single mic. But it picks up sounds from all
around including room noise, computer fans, and chair squeaks.
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Pick a mic at the appropriate price
You can find many different kinds of microphones, and they range
in price from cheap to astoundingly expensive. The main difference,
of course, is sound quality. Low-end microphones pick up only the
most basic sounds and provide adequate, but not great sound. The
higher-end microphones capture a much wider spectrum of sounds
that are rich, deep, and sound truly amazing. For example, podcast
pioneer Adam Curry uses a $2000 microphone. Mine retailed for
about $12.

NOTE “Great sound” is highly subjective. What one person hears as
fantastic may sound terrible to another. For example, some people
prefer the sound of old LP albums to CDs because they believe the
sound quality is better than that of CDs. Others think that Apple’s
encoding of songs in the iTunes Music Store sounds great (I’m one
of them), but others find it unacceptable and prefer a CD. (Of course,
a CD is a lower-quality transfer of master recordings, too.)

When I write that something produces great sound, I mean that the
majority of people would agree that it sounds good to them. Some
people will never accept the quality in any compressed format.

When I write that something sounds bad, I can identify certain char-
acteristics that most people would agree reduce the quality of the
sound. The audio may be noisy with hisses or strange high-pitched
warbles or there may be a lot of odd noises like loud popping or
static. Great sound starts with audio that is free from these defects.

I use an old Labtec headset with a built-in microphone attached
to a 1.25MHz 15-inch PowerBook G4, along with a Griffin iMic
(http://www.griffintechnology.com/products/imic/). Both are
directional.

For away-from-the-computer podcasting, I use an iRiver iFP-790
(http://www.iriveramerica.com/prod/ultra/700/ifp_790.aspx) and
a Griffin Lapel Mic (http://www.griffintechnology.com/products/
lapelmic/), also directional.

http://www.griffintechnology.com/products/imic2/
http://www.iriveramerica.com/prod/ultra/700/ifp_790.aspx
http://www.griffintechnology.com/products/lapelmic/
http://www.griffintechnology.com/products/lapelmic/
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In the interest of not spending any money and using what I already
have, I have also employed my digital camcorder’s built-in micro-
phone as a sound input device to interview people in the same room
with me as it has a good quality directional microphone (See the tip,
later in this ebook).

For my tastes, my audio is just fine. Then again, I was never a pro-
fessional deejay and probably have much lower standards than Adam
does. As always, you need to decide for yourself and your needs what
level of quality you desire.

If you want to learn more about choosing the right mic, read the
excellent article “What Microphone Do I Need?” by Jeff Towne at
Transom Tools. The article goes into great detail over types and uses
of different microphones (http://www.transom.org/tools/
recording_interviewing/200106.microphones.jtowne.html).

Decide on a breakout box or mixer
If you want to ramp up to more expensive professional tools, you can
find other hardware appropriate for advanced podcasters including
mixers and breakout boxes. A breakout box puts the audio in and out
of your computer in a convenient form factor—a separate box—which
keeps you from having to get to the back of your computer. This is
especially useful with desktop machines or computers that are located
far away from your workstation to reduce noise. Breakout boxes often
provide jacks for advanced audio like a connector that accepts a pro-
fessional microphone plug. Breakout boxes are handy for people who
do not have a sound input port on their computer. Many breakout
boxes use USB or FireWire to bring the sound in and you can shop
for various models based on your own needs.

TIP A plug is the male end of a cable and a jack is the female receptacle,
usually a port on your computer or on an external device such as a
breakout box. Generally, a microphone plugs into a jack or port.

External mixers provide inputs and output jacks as well, but also
allow you both to manage multiple input devices and control each
device’s volume and equalizer settings. For example, if you need to
have more than one microphone because you have multiple people
speaking, or if you want to record audio that is not already on your
computer but on another device, then you want a mixer to bring these

http://www.transom.org/tools/recording_interviewing/200106.microphones.jtowne.html
http://www.transom.org/tools/recording_interviewing/200106.microphones.jtowne.html
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different sources together into your computer. If you are all alone and
all audio is coming from your mouth and from your one computer,
then you do not need a mixer.

More advanced microphones require the use of phantom power,
electricity that runs along the same wire the audio signals travel on,
which can be provided by a mixer or pre-amplifier. These mics can’t
plug directly into a computer. For more information on phantom
power, see http://www.sounddevices.com/tech/phantom.htm.

Unless your podcast is 100 percent your voice and no other sounds,
you need a software-based mixer to handle mixing your voice with
other audio on your computer. I cover these programs ahead in Audio
Software You Need.

For this ebook’s purposes, I limit discussion of breakout boxes to
the Griffin iMic, a simple unit that takes a single 1/8-inch stereo input
and converts it to data carried over the USB connection. I cover this
item because it is the simplest and least expensive option for the
many Macs with no analog audio input port. (If you have a sound
input port, then you can connect a 1/8-inch–jacked microphone
directly to your computer unless it needs phantom power.)

http://www.sounddevices.com/tech/phantom.htm
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SIDEBAR TAKING YOUR SHOW ON THE ROAD

Many podcasters like to take their show on the road, bringing their
setup to do an interview face to face outside their home studio. Others
like to conduct “soundseeing tours” by walking through a place and
narrating what they see and hear. Mobility can be an exciting way
to spice up a podcast.

Methods for handling these road trips vary. Some people rig com-
plicated setups where they carry a laptop and record directly to disk
as they walk around. This is highly risky given that moving a laptop
while data is being written to the disk can permanently damage the
hard drive. Other podcasters use small devices such as Sony MiniDisc
recorders—common among print reporters for recording interviews.

Many podcasters recommend iRiver audio devices, so I bought one.
For about $90, you can get the iRiver iFP-790, a 256 MB flash-based
player that records directly to MP3 format. Other players in the iFP-
79x series include more memory, but 256 MB gives me over 2 hours at
the highest quality setting, which is more than sufficient for my needs.
http://www.iriveramerica.com/prod/ultra/700/ifp_790.aspx

I pair the iRiver with my Griffin Lapel Mic for an extremely portable
setup that gives me excellent-quality audio. I have taken this assem-
blage to several locations to perform audio tests and look forward to
performing my first real soundseeing tour in a future podcast soon.

If you own an iPod and don’t mind sacrificing audio quality, you
could record audio directly to your iPod with a Griffin iFM or a Belkin
Voice Recorder.
http://www.griffintechnology.com/products/ifm/
http://catalog.belkin.com/IWCatProductPage.process?Product_ID=15
8384

The downside here is that pre-fifth generation iPods (those before the
iPod with video) are limited to low-quality audio recording, too low to
be useful for podcasting. The fifth-generation models finally support
full CD-quality sound sampling, but no plug-in microphones are
available for those models currently.

http://www.iriveramerica.com/prod/ultra/700/ifp_790.aspx
http://catalog.belkin.com/IWCatProductPage.process?Product_ID=158384
http://www.griffintechnology.com/products/ifm/
http://catalog.belkin.com/IWCatProductPage.process?Product_ID=158384
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Audio Software You Need
Next you need software. Some podcasters record only their voice—or
multiple voices all sitting around the same microphone—and do not
mix in any other audio sources. Others record music, sound effects,
or remote voices coming in over Skype or iChat AV.

What recording software has in common
The four main recording programs I cover—GarageBand, Audacity,
SoundStudio, and Audion—have certain features in common. Each
displays your audio as a linear waveform moving forward in time
from left to right; each enables you to select any part of that waveform
and copy, cut, or delete that part; and each can paste any copied or
cut pieces anywhere else.

GarageBand provides the most extensive non-destructive modifica-
tion of the sound in which the original file remains untouched. You
can add reverb and echo, throw in audio effects, and modify the
volume without changing the underlying recording at all.

In the other three programs, making modifications changes the
actual recorded audio file and represents a one-way street. To that
end, always save a backup copy before editing audio in these pro-
grams so you can restore the original audio if you make the wrong
changes.

Each program has varying support for the two main forms of
recording audio:

• Live recording: In a live recording show, you queue up every
audio clip you intend to play, hit record and then play clips and
talk all in one long continuous stream from beginning to end much
the same way a DJ on the radio works. You do have some limited
ability to edit after the fact, usually to remove unwanted sounds.

• Planned recording: In a planned recording, you pull all the
clips you want to play into a program that lets you manage
multiple tracks of audio and record your voice as needed. You
repeat these recordings over and over again until you get it right.
You then manually adjust all transitions. These shows have far less
spontaneity to them, but they sound much more polished when
completed. Both methods work well and I have found uses for each
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depending upon what kind of show I was producing—or even what
mood I was in at the time.

All of that said, when I produce live recorded shows, I use Audio
Hijack Pro to record the show and SoundStudio for any final editing
that may be needed, either to remove unwanted content or to mix in
any audio I missed or thought of after the fact. For planned recording
shows, I use GarageBand for the complete show.

Choose among recommended audio software
For recording and/or editing audio, I recommend one or more of the
following programs:

• Audacity: Audacity is a full-featured program that can handle live
recording, multiple tracks (overlaying audio onto each other), and
a wide range of audio effects. You can use Audacity to edit out the
surprisingly many “ums” you utter (unless you were born to radio
and don’t have that, um, terrible, um, habit). It cannot mix live
audio from multiple sources without additional software (see Pull
Audio from Multiple Sources with Soundflower), and suffers from
stability problems. I have heard many stories of podcasters who
recorded a brilliant podcast, and, at 25 minutes into their magnum
opus, Audacity crashed and they lost the entire recording. That
said, many more people swear by it than at it, and you certainly
can’t beat the price.
http://audacity.sourceforge.net/ (open source, free)

• GarageBand: Apple Computer’s GarageBand is really a music
composition/noodling program, but it offers fantastic audio-input
capabilities. GarageBand can record live from multiple sources,
which lets you mix different input devices on the fly. It includes
audio effects as well. It cannot mix multiple software inputs such
as microphone and Skype and iTunes without additional software
(see Pull Audio from Multiple Sources with Soundflower).
http://www.apple.com/ilife/ (part of iLife ’05, which is bundled
with all new Macintoshes; suite sold separately for $79).

• SoundStudio: Freeverse’s SoundStudio is similar to Audacity. It
enables recording from a single input source, supports the mixing
of multiple tracks, and offers the capability to edit the actual sound
data. Although I have found it somewhat unstable—crashes are not
uncommon—it does do an excellent job of recovering from crashes

http://audacity.sourceforge.net/
http://www.apple.com/ilife/
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and I have never yet lost more than the last few moments of work.
It cannot mix multiple software inputs such as microphone and
Skype and iTunes without additional software—see Pull Audio
from Multiple Sources with Soundflower. (The new 3.0 version will
be covered in a free update to this ebook; unfortunately, I couldn’t
work in into this version.)
http://www.freeverse.com/soundstudio/ (2.x versions included
with some Macintosh systems, 3.0 available for $79.95).

• Audio Hijack Pro: From Rogue Amoeba, this Pro big-brother
of Audio Hijack is my personal choice for creating live, mixed
podcasts. Both versions enable you to record any sound on your
computer whether it be audio from a DVD you are playing, stream-
ing music from an Internet radio station, live microphone sounds,
or the sounds of whatever video game you may be playing. Where
Audio Hijack Pro really shines is in its ability to “hijack” the audio
from multiple applications and audio sources all at the same time.
With Audio Hijack Pro, I can record what I’m saying in my micro-
phone, what I am playing in QuickTime Player, and what some-
body else is saying in Skype all at the same time.
http://www.rogueamoeba.com/audiohijackpro/ ($32).

• Audion: Panic Software’s Audion is actually an MP3 player like
iTunes. It used to be a commercial product but has been aban-
doned by the developer and released free on the Internet. It is
of interest to us only because it can perform simple edits to MP3
files.
http://www.panic.com/audion/ (free)

Consider extra audio software tools
For some tools, you need some extra freeware tools to handle the
audio inputs.

• Soundflower: Soundflower provides a shared sound space for
sound from multiple sources. Think of it as a large bucket into
which you pour the sounds from multiple sources: microphones,
applications, and so on. This is an essential tool for the programs
listed above that cannot record multiple input sources simultan-
eously. (See Pull Audio from Multiple Sources with Soundflower.)
http://www.cycling74.com/products/soundflower.html (free)

http://www.freeverse.com/soundstudio/
http://www.panic.com/audion/
http://www.cycling74.com/products/soundflower.html
http://www.rogueamoeba.com/audiohijackpro/
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• SoundflowerBed: SoundflowerBed provides a simple menu
in the menu bar at the top to quickly change your Soundflower
settings (available from the same page as Soundflower).
http://www.cycling74.com/products/soundflower.html (free)

• Line In: Rogue Amoeba’s Line In offers a soft play-through of
sound from your microphone that routes the sound to an output
device you choose. Many of the tools I described earlier need this
function in order to work with Soundflower, because it lets you
route your microphone into the Soundflower space. (Audio Hijack
Pro has this function built in and does not require it.)
http://rogueamoeba.com/freebies/ (free)

• SoundSource: Also from Rogue Amoeba, SoundSource allows
you to change the settings you normally set in the Sound prefer-
ences pane in System Preferences from a handy menu instead
(available from the same page as Line In).
http://rogueamoeba.com/freebies/ (free).

Record phone and voice-over-IP interviews
Finally, if you want to conduct any interviews with somebody not in
the room with you, you need software that lets you conduct an audio
chat over the Internet

• iChat AV: Apple’s iChat AV (versions 2 and 3) provides a decent
audio chat capability. You can chat with other iChat AV users with
little effort. If you need to speak to somebody using Windows, you
can do so provided they are using a recent version of America
OnLine Instant Messager (AIM). The audio quality is OK but you
can do much better using one of the next two programs.
http://www.apple.com/ichat/ (included with Panther and Tiger)

• Skype: Skype provides surprisingly good audio quality and has
proven itself quite useful for conducting interviews over the
Internet. It can call telephone numbers, which lets you interview
people who are not running Skype.
http://www.skype.com/ (free for Skype-to-Skype calls, per-minute
rate for Skype-to-telephone calls)

• Gizmo: Gizmo is similar to Skype in most areas that matter to
podcasters. However, Gizmo can record any call directly to an
MP3 file. This means that you can record interviews directly with-
out having to work with another audio recording program as you

http://www.cycling74.com/products/soundflower.html
http://rogueamoeba.com/freebies/
http://rogueamoeba.com/freebies/
http://www.apple.com/ichat/
http://www.skype.com/
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would with Skype and iChat AV. As of this writing, however, the
quality of the MP3 is too poor and not adjustable for better quality.
http://www.gizmoproject.com/ (free for Gizmo-to-Gizmo calls,
per-minute rate for Gizmo-to-telephone calls).

TIP If you want to record audio from a cell phone or land line, it’s not
impossible to get high-quality results, but it’s not cheap. An $80
CellTap adapter from J.K. Audio lets you take an 1/8-inch audio feed
out of a cellular conversation, but it can cost several hundred dollars
for a good landline extractor. If you’re willing to spend the money,
consult J.K. Audio’s catalog (http://www.jkaudio.com/): they’re
working hard now to serve podcasters.

Set Up Audio
In most cases, you should be able to simply plug in an audio device
and start recording.

However, the computer’s current settings for audio input may create
recordings that sound awful, like bad static over your voice. If that
happens, some other software on your computer is controlling your
audio input jack (line-in or USB or other), and it is capturing 8-bit
audio samples instead of 16-bit samples.

TIP Samples are tiny, rapidly taken digital “snapshots” of an analog
stream of audio. For example, a typical CD-quality recording uses 16
bits to represent any of 65,536 different audio tones, captured 44,100
times per second. In contrast, an 8-bit sample, no matter how rapidly
it’s captured from source audio, has only 256 tones.

Luckily, the fix is simple using Apple’s Audio MIDI Setup utility:

1. Launch Audio MIDI Setup utility (found in the Applications/
Utilities folder).

2. Choose the audio input you are using from the Properties For pop-
up menu on the middle left.

3. Further down the window, set Audio Input and Audio Output both
to “44100.0 Hz” and “2ch-16Bit” (Figure 1).

These settings remove the static from your recording.

http://www.gizmoproject.com/
http://www.jkaudio.com/
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FIGURE 1

Set Audio Input and Output both to “44100.0 Hz” and “2ch-16bit”.

TIP Even though I have a mono mic I leave my audio input settings set
to “2ch-16bit” rather than “1ch-16bit” because I also connect external
stereo devices. I don’t want to change this setting back and forth. All
software referenced in this ebook works just fine with a mono mic
on a stereo setting.
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RECORD YOUR PODCAST

Ultimately, recording a podcast is about capturing audio. You may
record your voice, include a song, interview somebody over Skype or
iChat, or play sound effects. No matter what the source of the sound,
it has to be captured and recorded by software on your computer.

In this section, I walk you through several software programs that I
recommend using for audio capture: Audio Hijack Pro, GarageBand,
Audacity, and SoundStudio, and then pull it all together with tips on
Soundflower, a shared audio space that makes all these other tools
work better with multiple audio streams.

WARNING! Be careful about the rights to the music you play. If you play music
to which you do not have the rights, you could be sued for a great deal
of money. Some podcasters have gotten around this by obtaining
licenses that provide them the right to use music in their podcasts.

Tracks that the artists have granted anyone the right to use, provided
they are given credit are called pod safe. The Podsafe Music Network
(http://music.podshow.com/) is a great source of pod-safe music.

You can pay for a license to use music, but it can cost a fair amount of
money and require contacting multiple organizations, principally but
not exclusively BMI (http://www.bmi.com/licensing/webcaster/,
click Website Music Performance Agreement) and ASCAP
(http://www.ascap.com/weblicense/). These two clearinghouses
charge a minimum of about $300 a year each to use songs in their
rights catalogs—and that’s just the minimum.

Bret Fausett has posted the results of his research into rights
licensing for podcasts in podcast form on his site
(http://blog.lextext.com/blog/_archives/2005/1/4/225172.html).

http://music.podshow.com/
http://blog.lextext.com/blog/_archives/2005/1/4/225172.html
http://www.bmi.com/licensing/webcaster/
http://www.ascap.com/weblicense/
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Use a Microphone Well
Before recording, let’s talk a little physical reality: Setting up and
talking into a mic. There’s an art to using a microphone that requires
years of experience. Nevertheless, a few quick tips cover most of what
you need to know:

• Keep the mic away from your mouth: You do not want the
microphone up against your mouth. It is best if the microphone
is a few inches away and somewhat above or below your mouth
so that you do not breath directly into it. This helps prevent plo-
sives or popping sounds, usually generated by the letter P, and
helps reduce S sounds, which I generally eliminate by playing
with the equalizer.

• Angle the mic: If possible, point the microphone down toward
your mouth from above to reduce plosives, nasal tones, and lip-
smacking sounds. In my case, I use a headset that does not really
allow me to position the microphone above my mouth. Instead,
I place mine down nearer to my chin and angle it outward so it
is not in the direct path of the wind from my mouth. (If I had my
druthers—and the budget—I would get a freestanding microphone
and place it a few inches away and pointing downward toward
my mouth.)

• Use a windscreen: If you can get a microphone with a
windscreen—a foam shield that covers the microphone—that
helps a great deal in preventing plosives or wind noise when
used outside.

TIP Some people also swear by a variation on the windscreen made
by stretching a piece of nylon pantyhose over a hoop in front of the
microphone to reduce plosives. These can be made at home easily
enough and are also available commercially.

Record with Audio Hijack Pro
Audio Hijack Pro enables you to manipulate complicated streams
of audio on your computer. At its simplest, it can take the standard
audio input and record it to a file. But has much greater capabilities:
the program can take in audio from multiple sources, mix those
tracks together, post-process the sound with any number of inter-
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esting (or scary) audio effects, and then encode the audio directly
to an MP3 format file (see Encode Your Podcast).

With Audio Hijack Pro, I can do lots of recording tasks—record
interviews using Skype, play music, create voiceovers, and more. The
application has never crashed on me, and switching applications while
recording does not result in any dropouts or other weird problems.

Install programs at first run
The first time you run Audio Hijack Pro, it suggests that you let it
install three extras.

• Instant Hijack: This system utility allows Audio Hijack Pro to
grab audio from any running program. Without installing Instant
Hijack, Audio Hijack Pro needs to quit and re-launch a running
program to hijack its sound. This gets in the way of setting up all
your sound sources in advance (see Make a podcast).

WARNING Instant Hijack belongs to a category of software known as haxies,
which many believe can cause random system crashes. I have not had
any troubles with crashes, but if you are concerned, don’t install it.
Instead, accept that you need to let Audio Hijack Pro launch each
program when you hijack those programs’ audio outputs.

• Soundflower: You may or may not need Soundflower depending
on the complexity of your podcasts (See Pull Audio from Multiple
Sources with Soundflower). There is no harm in installing this
extra; it may well come in handy.

• Schedule Helper: This utility makes scheduled recordings
without Audio Hijack Pro already launched. Without it, you have
to leave Audio Hijack Pro running all the time or set as a startup
program (Launch System Preferences, open the Accounts prefere-
nce pane, and use the Login Items tab). If you plan on scheduling
recordings then you should install this extra. For instance, I use
this feature to record CBC Radio’s The Vinyl Cafe every Sunday
at noon (http://www.cbc.ca/vinylcafe/).

http://www.cbc.ca/vinylcafe/


Page 24

Set up Audio Hijack Pro
To set up Audio Hijack Pro for your podcast, launch the program,
and then carry out the next steps:

1. At the bottom left, click the  button to start a new session. Name
the session whatever you want. I put a 0 (zero) at the beginning of
the stream name in Figure 2 to keep it sorted at the top of my list.

2. Click the Input tab (if you’re not already viewing the Input pane).
Set your audio input to your current microphone by selecting it
from the Input Device pop-up menu. Figure 2 shows the settings
for my iMic USB from Griffin. You may be using line-in or even
the built-in mic.

FIGURE 2

The input options for your podcast session in Audio Hijack Pro. Notice
the buttons at the lower right, which you click to switch to panes
where you set recording and effects preferences for the session
selected at the left.

3. Set your audio output to your headphones by selecting an option
from the Output Device pop-up menu. This lets you hear what you
are recording. In the case of Figure 2, the headphones are con-
nected to an iMic USB.
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4. Click the Recording tab. Choose the audio format you wish to use.
If you are in doubt, stick with AIFF (auto) (Figure 3). (See
Encode Your Podcast for a discussion of encoding formats.)

FIGURE 3

The Recording options for your podcast session in Audio Hijack Pro.

5. At the bottom of this pane, fill in values for your tags. (See Tag
Your Podcast for a discussion on tagging your podcast.)

6. Click the Effects tab. This is the most complicated pane, but also
the most fun. Here is where I have already added all the effects
that I use to make myself sound better. I then mix in other audio
sources and monitor the levels on my entire podcast. These audio
effects are applied in real time rather than after recording is
completed. Figure 4 shows how I set these set up.
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FIGURE 4

My effects are set up and ready to go with a full set of recommended
effects for a podcast recording session.

You might wonder why I chose the particular set of effects shown in
Figure 4. Let me walk through the reasoning behind each effect and
the values assigned to them (not visible in the figure):

• 10-Band EQ: I use this to tweak my voice and drop out some of
the room noise (mainly the hiss from the central air system of my
house). I also adjust the EQ settings so spoken “S” sounds are far
less hissy; otherwise, it’s annoying to listen to.

• Reverb: I add just a touch of reverb so my voice doesn’t sound
quite so flat. You need only a little unless you want to sound like
you record your podcast in a cathedral.

• Declipper: This effect makes sure that no overly loud sounds
make it through to your recording. It quiets the loudest sounds,
which is a good idea as overly loud sounds badly distort your voice.

• Application mixers: I mix sounds in from QuickTime Player
and Skype. You can also mix in iChat AV and any other application
from which you need to record sounds.
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• Inspector: This doesn’t actually change your recorded sound
but displays a window showing your current levels which helps
you monitor output volume.

When all the input/output preferences are set, you are ready to
record.

TIP Earlier, I mentioned that I once used my digital camcorder as a micro-
phone to conduct an interview. Here’s a quick look at how I did it:

1. Connect the camcorder to a PowerBook or iBook via a FireWire
cable.

2. Remove the videotape from the camcorder. Most camcorders go
to sleep after a few minutes of inactivity with a tape in. Without the
tape, they stay on indefinitely.

3. Launch iMovie and put the program into capture mode. The iMovie
window begins displaying live video and playing live audio.

4. Leave the lens cap on to avoid distraction.

5. Use Audio Hijack Pro to grab the audio from iMovie and save it to
an audio file.

When an interview is over, I use SoundStudio to edit the audio to
remove undesirable content and chop the audio into multiple shows,
add my intro/outtro, and post it as a podcast.

Make a podcast
Here’s a window into how I make a podcast using Audio Hijack Pro.

Prepare all audio
I open all audio clips I want to play in QuickTime Player (Pro or
regular), even music files. I don’t use iTunes because the window
takes up much more room than a bunch of smaller QuickTime Player
windows. I also don’t have to worry about iTunes starting on the next
song if I forget to stop it at the end of the one I was playing.

You can open iTunes music in QuickTime through these steps:

1. Find the song in iTunes.

2. Choose File > Show Sound File (or press Command-R, or Control-
click the track and choose Show Sound File).
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3. Drag the exposed file in the Finder onto the QuickTime Player’s
icon in the Dock.

Record the show
Once everything is on my screen (Figure 5) and ready to roll, I click
Hijack at the top of the Audio Hijack Pro window, get my headphones
on, and verify sound levels by performing a quick test: I click Record,
talk for a few seconds, and click Record again to stop recording. I
switch to the Recording Bin in the session list on the left side of the
Audio Hijack Pro window, locate the most recent file, and click the
Preview icon. If it all checks out, I throw that file away and return
to my podcast session.

FIGURE 5

My complete screen for making a podcast. On the left are the
QuickTime windows, one for each clip or song I plan to play. Below
them at the bottom left are Skype and iChat windows in case I have
any conversations with other people planned. In the middle is the
main Audio Hijack Pro window. On the upper right are the Application
Mixer windows for QuickTime and Skype. On the bottom-right is my
Inspector window so I can monitor my audio levels.
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Once you’re ready to go, take a deep breath and begin. Here’s a look
at how I do my podcast recordings:

1. I click Record to start Audio Hijack Pro recording.

2. I say the podcast name and date.

3. I click Play on my intro music in its QuickTime Player window.

4. At a certain point in my intro music, I drop the volume using the
slider on the Application Mixer window in Audio Hijack Pro for
QuickTime and begin my standard intro.

5. I talk, and, when I need to play other audio files, I click play in the
various QuickTime Player windows, adjusting volumes as needed.

6. I record my outtro, including the title of my show, my name and
contact information, and the address of my website.

7. I stop the recording by clicking Record again.

From here, I move on to SoundStudio to trim. I usually need to clip
just a touch off the front, because I tend to click record and then wait
a second before I start talking. I save the final cut of my podcast and
I’m ready to compress it and get it online!

TIP To make your podcast more useful, announce the podcast name
and date at the very start of your show before any intro music is
played. This helps people who are using MP3 players that do not
have screens (such as the iPod shuffle), and people who are not in
a position to see their screen. Once listeners know the show title
and date, they can decide whether or not they want to listen to it
or skip to the next track on their device.

Record with GarageBand
Podcasting with GarageBand has its pros and cons. On the pro side,
you sequence all the different parts of your podcast into separate
tracks, which gives you fine-grained control over audio transitions
and timing.

For example, when recording using Audio Hijack Pro, I constantly
goof up the reduction in volume of the intro music when I begin
speaking. My hand slips and I fade it much too quickly, or I don’t fade
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it enough and it is too loud, drowning out my voice. I invariably have
to either just let it go and leave it in, or go back and re-record it.

With GarageBand, I can adjust the volume of each track by hand and
adjust the timing. Did I start speaking too late? I just move the track
to the left to fix that. On the other hand, this is also a problem for
podcasting with GarageBand as I lose most of the spontaneity of
creating the podcast. I have to record each bit on its own and then
manually sequence them together. I am far less likely to have that
feeling of rawness that many value in podcasts.

Unlike Audio Hijack Pro, GarageBand can record only from a single
sound input at a time. If you want to mix multiple sources of audio,
you need to channel that audio into Soundflower and then have
Audacity record the Soundflower space. (See Pull Audio from
Multiple Sources with Soundflower for details.)

First, we set up a special instrument within GarageBand. Launch the
program, create a new file, and follow these steps:

1. Choose Track > New Track. The dialog in Figure 6 appears.

2. Click the Real Instrument tab at the top.

3. Select Vocals from the left-hand list.

4. Select No Effects from the right-hand list.

5. Choose Channel 1 & 2 (Stereo) from the Input pop-up menu. I
have a single mono microphone, but find no difference between
choosing Channel 1 (mono) or the default stereo setting.

6. Choose Off from the Monitor pop-up menu. If this setting is turned
on, you hear yourself through your headphones, which I find to
cause more trouble than it is worth. (Never turn this on if you are
not using headphones as you create a nasty feedback loop and
create some awful noises.)
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FIGURE 6 This screenshot of the New
Track dialog shows how I
configured my “Podcasting
Voice” custom instrument.

7. Open the Details expansion triangle to set additional options:

• Gate: Leave unchecked. The Gate setting silences any noise
below the value you set, which removes that constant hiss that
appears on recordings outside of true sound-controlled
recording booths. However, I find that it makes the hiss come
when you talk and go when you are silent. It never sounds very
good in practice.

• Compressor: I set the Compressor slider about 1/3 from the
left. This helps spread the sound coming in through the micro-
phone across the entire range, giving your voice some dynamic
lift and making it sound far less flat than it otherwise might.
Play with this setting to see what works best for you.

• Filters: I don’t use either of these but I sure do like playing
with them. They can be quite useful if you are going for special
effects in your show.



Page 32

• Equalizer: I created a custom setting because I had a lot of
trouble with the letter S, which sounded like a nasty hiss. Play
with this setting until you like how you sound.

NOTE As soon you choose an Equalizer value other than Manual, you are
prompted to create this instrument by providing a name under which
it is listed. You can still make changes and save it again using the
Save Instrument button that then appears.

• Echo: Leave off. Unless you are announcing a Monster Trucks
commercial, there’s no need for an echo.

• Reverb: A little reverb goes a long way. I set mine about 1/6
of the way from the left to give just a hint of depth to the space
around me. Normal microphones in a normal room sound
pretty flat. Adding a touch of reverb makes the voice seem more
real and more like somebody is actually there speaking to you.
Again, play with this setting to find a value that works for you.

8. To finish with Track Info, click Create.

9. A prompt appears, asking you to provide a name for this instru-
ment. You can use any name that you like; I named mine
“Podcasting Voice.”

Now record your segments. With your voice instrument set up and
metronome turned off (Command-U), click the Record button and
start talking. If you don’t like what you recorded, throw it away and
start over.

Once you have all your vocal tracks completed, you are ready to edit
your audio and mix in other tracks, as I describe in Edit Your Podcast
with GarageBand.

Record with Audacity
Audacity is a well-respected audio recording and editing program that
has a strong following. It packs a lot of power and a large feature set
and is up to virtually any editing task you may want to throw its way.
On the negative side, though I haven’t seen much of this behavior, I
have heard many stories about Audacity crashing before saving audio.
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NOTE There has not been a new version of Audacity in nearly a year, which
suggests that the project has stagnated. Most open-source projects
with bugs or stability problems either improve through rapid releases
or die. It is not clear which category Audacity fits into at this time.
Given its popularity with podcasters, I would be surprised if it was
a dead project; I think it’s just resting.

Like GarageBand, Audacity uses a multi-track metaphor. Each track
can contain different audio files that can be mixed together. You need
to channel that audio into Soundflower and then have Audacity
record the Soundflower space. See Pull Audio from Multiple Sources
with Soundflower for details on doing this.

Follow these steps to configure and record audio with Audacity:

1. Choose Audacity > Preferences, and in the Audio I/O pane, set
your input and output settings to match your configuration
(Figure 7).

FIGURE 7

My Audacity settings for podcasting. I monitor through headphones
(which I don’t pass through the iMic to help reduce lag), I record
through the iMic, and I only use a single (mono) channel, as I do
not have a stereo microphone.
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2. Start recording and speaking. The levels meter on the upper right
let you know if you are talking too loudly or quietly. You may have
to create several takes at first to get a feel for the right settings and
volume in your own voice.

3. You can record additional spoken word tracks as needed and move
all the different pieces around as suits your tastes.

Once you have all the pieces recorded, you can move on to editing
your show See Edit Your Podcast.

Record with SoundStudio
SoundStudio enables you to work on a single audio track at a time,
which makes it the most limited tool but also the simplest to use. This
may cause you to choose SoundStudio to avoid complexity. The trick
is mixing together the various parts of your show: your voice, music
you play (including intro/outtro music), and so forth.

NOTE SoundStudio released version 3.0 while this ebook was being
finished. Click the Check for Updates button on the cover to learn
about plans for a free update that covers SoundStudio 3.

Two methods let you get around this limitation. First, route audio
from multiple sources into Soundflower, and then record the Sound-
flower channel within SoundStudio (see Pull Audio from Multiple
Sources with Soundflower). Second, use SoundStudio to merge the
different audio tracks after they are all recorded and otherwise ready
to be mixed. I advise against this latter approach as it is takes the
most time. You have far better ways to handle this, such as bringing
all tracks into GarageBand or Audacity and using either of those
programs to handle the mixing.

Here’s how to set up SoundStudio and record:

1. Choose SoundStudio > Preferences and set your input and output
settings to match your configuration (Figure 8).
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FIGURE 8

Set the preferences to match your setup.

2. Start recording and speaking. The levels meter (found in a separate
window that you can show or hide in the Windows menu) lets you
know if you are speaking too loudly or quietly, and you may have
to do several takes to find the right settings and volume for your
voice.

I monitor through headphones (which I don’t pass through the iMic
to help reduce lag) and record through the iMic. The Left and Right
channel controls determine where audio from the two channels winds
up. Since I use a mono microphone, controls are set to Channel 1. If I
were to set right to 2 for input, my voice would appear only on the left
channel.

When you finish recording, you can then turn your attention to
editing the file and, perhaps, mixing it with other audio files to build
your show. I cover editing in Edit Your Podcast with Audacity later.

Pull Audio from Multiple Sources with
Soundflower
If you choose not to use Audio Hijack Pro, you need to use Sound-
flower to pull together audio from multiple sources. Programs like
Audacity and GarageBand specialize in audio mixing and editing,
not incorporating sound from other programs like Skype, iChat,
QuickTime, or iTunes. (You might use Soundflower with Audio Hijack
Pro, too, to route application audio directly to other programs.)
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Soundflower creates a single virtual audio source that can be used 
in any program, and that appears to all intents and purposes as if it’s 
just a single source of audio. But you can route the sound from many 
different programs and sources into Soundflower, just like taking 
water from hoses connected to different faucets and having that water 
pool in a single bucket. You can then record directly from the shared 
sound space that is the Soundflower device (Figure 9). 

FIGURE 9 

 

Audio is routed 
from multiple 
applications 
directly into 
Soundflower 
where it is all 
mixed together. 
Your recording 
application 
records directly 
from this space 
and your head-
phones listen 
to it as well so 
you can hear 
what you are 
recording. 

   It can be a bit convoluted to set up, but once you have it all working, 
you have great flexibility in how you mix your podcasts. 

Here’s how this might work with GarageBand: 

1. Download and install Soundflower (see Audio Software You Need). 
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2. Open System Preferences and click Sound (Figure 10).

FIGURE 10 Configure
the Sound
preference
pane in
System
Preferences
to prepare
for running
Soundflower.

2. Set each tab as follows:

a. Sound Effects: Set Play Alerts and Sound Effects Through
to your headphones. This keeps random alert sounds, new mail
sounds, and other random noise from appearing in your pod-
cast. If you actually want these sounds in your podcast, by all
means set this to Soundflower (2ch) also.

b. Output: Set to Soundflower (2ch) to direct all audio output
generated by all applications on your computer to send their
sound to Soundflower (2ch) rather than the speakers or your
headphones. This covers all applications that do not let you
set their output directly.

c. Input: Choose your input device (Internal Microphone, Line
In, iMic USB audio system, etc.).

3. Once you establish your default sound settings, you need to set
up audio in programs that have their own sound controls, such
as Skype and iChat AV—each of these programs has audio prefer-
ences that determine where the programs get their audio input and
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where they send their audio output. In the case of these two pro-
grams, set their inputs to your microphone and their outputs to
Soundflower (2ch) as in Figure 11.

FIGURE 11

Skype’s audio settings to direct all sound from Skype to Soundflower
(2ch). Note that in iChat AV, the audio settings are on the Video tab.

4. Open GarageBand, Audacity, or SoundStudio and set up a new file
as I describe earlier in this ebook.

5. In that program’s preferences, look for the audio input/output
settings (Figure 12). Set the input to Soundflower (2ch) and the
output to whatever you are using to monitor your podcast
(presumably, your headphones or an iMic or similar).

FIGURE 12 Audio
preferences for
GarageBand.
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6. From this point onward, follow the instructions that I gave earlier
for the program you are using. You can now record audio from
multiple external sources including iChat and Skype conversations.

You can also play music directly from iTunes and QuickTime and
record that music as these programs play, but I still think it is easier
to work with these files as discrete tracks for the fine-grained control
you have over the volumes and timing of the files.
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EDIT YOUR PODCAST

Once you have recorded all the pieces of your podcast, you may want
to edit them, either to sequence pieces together or to remove anything
accidental you don’t want in there such as excessive stumbling in your
speech or other mistakes. (Whether you edit at all is a personal choice.)

Edit Your Podcast with GarageBand
GarageBand provides the greatest flexibility in that it allows you to
easily mix different tracks together and modify the properties of each
track (including filters, equalizer settings, echo, reverb, and more)
without changing the underlying recorded audio. It overlays filtering
on top of the track and does not make destructive changes to the data.

You can also edit the tracks to remove gaps, speech stumbling, and
other unwanted content as well as cut, copy, and paste audio bits into
other locations. Those edits, however, do permanently change the data.

Add additional audio
Drag in any audio you plan to use. You can bring in any MP3, AIFF,
or AAC format files (except iTunes Music Store purchases, which are
protected and bookmarkable AAC files). Each time you drag in a new
audio file, GarageBand puts it into a new, unique track (Figure 13).

FIGURE 13

In this GarageBand example, the top track is the intro/outtro music.
The second track is a recorded voice saying hello and welcome. The
third track is a song. The intro/outtro plays alone for a few seconds,
then the voice starts, and then the song starts and overlaps with the
voice.
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Edit your voice
You may want to remove any “ums” or other distracting noises from
your vocal track. Or you may have gone off on a tangent, which, on
listening to it again, you realize is boring and pointless, and want to
remove it:

1. Select your vocal track and choose , the Track Editor button,
which is next to the eyeball on the lower left. This brings up the
track editor in the bottom half of the window as in Figure 14.

FIGURE 14

Edit mode lets you edit specific details of a given track. As this is
recorded audio, you are presented with a sound wave.

2. Listen to your vocal track and identify any place where you have
something to remove. When you do hear something, tap the space-
bar to pause the playback and take note of where the red playhead
is located. The playhead should be just after the undesired sound
begins. To verify that you found the right bit, you may want to
move the playhead back and tap the spacebar to start playback
again.
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3. Once you are sure you’ve found the right end-spot, select the audio
by dragging from the start of the sound to the end of the sound
(Figure 15).

FIGURE 15

Here I have selected an “um” to delete.

4. With the undesired sound selected, choose Edit > Cut. Unlike
other audio editors, GarageBand does not shift everything to the
right of the cut towards the left but instead leaves a gap where you
removed the sound (Figure 16).

FIGURE 16

The gap left by removing the selection above.
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5. Drag the sound block on the right over to the left to line up with
the left sound block (Figure 17).

FIGURE 17

The sounds are together again with the offending “um” removed for
good.

The offending sound is now gone and the only sign that something
has changed is the fact that your track shows more than one sound
block where it used to have only one (Figure 18). This is just a visual
indicator of edits, and it doesn’t affect your audio.

FIGURE 18

GarageBand now shows that the “Podcasting Voice” track holds two
objects instead of one.

Mix tracks
After you record or import all your audio into GarageBand, you can
move chunks of audio around to start and end when you want them
to, and you can adjust their individual volumes to have them fade
in and out as needed.
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GarageBand indicates volume with blue lines and light blue shaded
areas under the actual track data, which are orange, green, or purple
depending on whether they are, respectively, software instruments,
imported audio, or real instruments. The higher the blue line, the
louder the sound is at that point.

Notice in my example in the step-by-step instructions just previously
that the intro starts at full volume and then fades out right when the
voice track starts. The voice track has no volume control displayed,
and is played at full volume from start to finish. Meanwhile, a song
slowly fades in under the voice and reaches full volume right as the
voice finishes up introducing the song.

In order to achieve this professional mixing effect, try the following:

1. Drag each audio file from the Finder to the GarageBand window.
GarageBand puts each dragged-in sound into a separate track and
starts it at the point in the timeline where you dropped it. As you
drag an audio file in, the playhead appears, showing the audio’s
start time. Move the dragged-in audio left or right until you get
it close to where you want it (Figure 19).

FIGURE 19

Space the three tracks so the audio for each begins when needed.
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2. To manage the transitions between the tracks, click the volume
button (circled in red in Figure 20) in each track, which gives you
individual volume control for each track (the blue area under the
orange track in Figure 21). Then you can fade out one thing while
fading in another.

FIGURE 20 Click the volume button (circled in red)
to reveal an individual track’s volume
controls.

FIGURE 21

Close-up of the voice track (purple), song track (orange), and song
volume (blue).

3. Decide when you want the fade-in of the song to begin, and click
the blue volume line to create a control point (Figure 22).

GarageBand inserts a control point at the spot where you clicked.

FIGURE 22

Create the first control point in the song’s blue volume control.

4. Drag the leftmost control point at the start of the track to the
bottom (Figure 23).
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FIGURE 23

Drag the left edge of the line to the bottom.

5. Create another control point where you want the song to reach full
volume. In Figure 24, this is when the voice track ends.

FIGURE 24

Create the second control point where the voice track ends.

6. Drag the first control point you made to the bottom to set the point
where the fade in begins. In our example, the song gently fades in
under the speaking voice and reaches full volume when the voice is
finished (Figure 25). You may need to adjust the fade-in by add-
ing additional control points to ensure the volume of the song
doesn’t drown out the final words in the voice track.

FIGURE 25

Drag the first control point you made to the bottom to create the
desired transition.
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Edit Your Podcast with Audacity
Audacity is popular among podcasters because it offers powerful
editing and mixing features in a free software package. Its interface is
certainly rough around the edges, but once you get familiar with how
Audacity works, its power overcomes any limitations in its interface.

Add additional audio
You can import other sounds into your Audacity project. For example,
you can import your intro and outtro music, any MP3s (but not AAC
format files) you may want to play, and so forth. To add audio to your
podcast, follow these steps:

1. Choose Project > Import Audio and locate any files you want to
include in your project. After adding the files, your window will
look something like Figure 26.

FIGURE 26

This Audacity window showing three newly added audio tracks.
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2. From the selection of tools at the upper left of the window, pick the
double-arrow tool (lower row, middle icon). Now, drag the tracks
to set their start times, as in Figure 27.

FIGURE 27

I moved my voice (middle track) to start part way into my intro
music (about where the volume drops), and I moved the song
(bottom track) to start as my voice track finishes.

TIP Audacity can add labels (the bottom track with red type in Figure 27)
to help you keep track of parts of the recording or when different
transitions should happen.

Edit your voice
Editing your voice track is simple. Here are the steps:

1. Select your vocal track and choose the edit tool (the I-beam icon at
the upper left).
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2. Listen to your vocal track and identify any place where you have
something to remove. When you hear an extraneous sound, tap the
spacebar to pause the playback and take note of where the black
cursor is located. It should be just after the undesired sound. You
may want to move the cursor back and tap the spacebar to start
playback again just to verify that you found the right bit.

3. Select the offending audio by dragging from the start of the sound
to the end of the sound (Figure 28).

FIGURE 28

Select the offending sound.

4. Press the Delete key to delete the selected sound (Figure 29).

FIGURE 29

Audacity has removed the sound and snapped the audio to the right
of the gap to the start of the deletion.

Mix tracks
Audacity has a weak spot for podcasting: the program only edits
destructively. Change the volume of a track, and you’ve irrevocably
changed the original recorded sound. It can’t fade, either, but only
change the overall volume of a selection. You can, however, fade a
sound in or out completely, but there’s no loud to soft or soft to loud
settings.
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Audacity provides some complicated features in place of simple
transitions to handle cross fades between tracks but their complexity
places them beyond the scope of this ebook.

Edit Your Podcast with SoundStudio
SoundStudio provides the same type of editing features as Audacity
but operates on only one sound file at a time. SoundStudio provides
no separate tracks and any mixing between separate audio sources
almost certainly requires the use of a different program. However, as
a sound editor, it is one of the most powerful and easiest to use, and it
is excellent for preparing individual files for inclusion in a podcast or
for doing final processing on a newly completed podcast.

NOTE This ebook covers SoundStudio 2. Version 3 has recently been
released and will be covered in a free update to this ebook. Click the
Check for Updates button on the cover of this ebook to learn more.

Add additional audio
Aside from using Soundflower to live-mix multiple sources, you
cannot add additional audio to a single project beyond SoundStudio’s
complicated mixing system (described ahead).

Edit your voice
SoundStudio’s audio editing interface is quite similar to Audacity’s
and GarageBand’s in that you can remove unwanted sound as needed
through a simple select and delete/cut. Like Audacity everything to
the right of a removed section snaps left to fill in the gap.

To edit your audio, follow these steps:

1. Listen to your vocal track and identify the starting point of audio
you want to remove. Use the Cue timer at the top of the audio
window to pinpoint the precise start time.

2. Press the spacebar when you reach the right starting point.
Unfortunately, SoundStudio doesn’t display a cursor showing the
point you’re paused at. Click as close to that point as you can, and
then use the Start timer to see if you’re on top of the precise
moment.
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3. Start playing the audio again. When you reach the end of the piece
you want to remove, press the spacebar. Watch the Cue timer
again to know where you want to stop.

4. Holding down the Shift key, click at the point where the unwanted
sound ends. Use the End timer to click closer to the precise
moment you wanted while holding down the Shift key to change
the selection distance (Figure 30).

FIGURE 30

I have selected the offending sound.

5. With an area selected, click the Play button. SoundStudio plays
the selected segment. You can now fine-tune the selection. Use the
zoom slider at the bottom left of the audio window to see a finer or
coarser view, in order to make a better selection.

6. Choose Edit > Cut (Command-X) if you intend to paste the audio
somewhere else. Press Delete if you want to discard it.

SoundStudio removes the extra audio and automatically fills the gap
with the sound that was to the right of it (Figure 31).



Page 52

FIGURE 31

The sound has been removed and the gap automatically filled in by
what was to the right of it.

Mix tracks
You can mix two audio files together using a cross-fade paste feature
but this fade permanently alters the sound files. As such, I do not
recommend using SoundStudio 2 to mix audio; GarageBand is the
better option.

Edit Your Podcast with Audion
Audion has the unique capability to edit MP3 files directly, with as
much ease as other programs handle AIFFs. Even though I think it’s
a bad idea to record directly into MP3 format—see Choose a File Type
for why—Audion is the only tool to work with if you must use MP3s.
You can also use Audion to tweak a file you’ve encoded into MP3 from
a master file, but I would argue you are much better off re-encoding,
unless you are in a time crunch.

Audion’s editor is based upon SoundStudio and looks quite similar.
Unlike SoundStudio, Audion provides only the capability to cut, copy,
and paste selections and nothing else. Please refer to Edit Your
Podcast with SoundStudio, earlier, for directions.
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ENCODE YOUR PODCAST

Your final, spiffed-up product is likely a large file in a raw audio
format, such as AIFF, that needs to be encoded into MP3 or AAC
format. These formats compress the audio down to a reasonable size
so that you can share the file on the Internet.

Choose a File Type
Always record directly to AIFF, edit, and then encode to either MP3
or AAC (see Table 1, next page, for format details). Here’s why:

• Encoding to a compressed format requires a lot of processing
power. Making your computer encode on the fly while you try
to sequence audio from multiple sources can overpower most
computers, and you risk having some of your audio drop out
as the computer fails to keep up with all its tasks.

• I prefer to have a full-dynamic-range master of my shows and then
experiment with encoding options. If I have a show that is mostly
talk, I encode it one way; if it has a lot of music in it, I encode it
using another method. Because it can be hard to know what will
work best before you record the show, I suggest that you leave
encoding until the end, so that you can perfect your settings.

In general, I recommend you stick to MP3 unless your audience all
uses iTunes (along with an iPod), in which case AAC is the superior
option. (AAC is a subset of the MPEG4 standard, which is why we’ll
see more devices handling it over time.) For example, Doug Adams
uses AAC rather than MP3 for a podcast about his AppleScripts for
iTunes. He can be 100 percent certain that his audience uses iTunes—
why would anyone not using iTunes care about his podcast?
(http://www.dougscripts.com/itunes/itinfo/podcast_info.php).

iTunes is your best and nearly only choice for encoding: Among
Audacity, Audio Hijack Pro, GarageBand, and SoundStudio, only
Audio Hijack Pro can encode as MP3 while recording and none can
encode as AAC. (Audacity can encode MP3 files with additional
software libraries installed, see http://audacity.sourceforge.net/help/
faq?s=install&item=lame-MP3.)

http://audacity.sourceforge.net/help/faq?s=install&item=lame-mp3
http://audacity.sourceforge.net/help/faq?s=install&item=lame-mp3
http://www.dougscripts.com/itunes/itinfo/podcast_info.php
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Table 1: Audio Format Comparison

Audio
Format Advantages Disadvantages

AIFF • Best possible audio quality (the underlying
format used for audio CDs)

• Unencoded, thus better for production work
without loss; avoids computational load

• Too large for Internet
audio

• Files are not
bookmarkable

MP3 • Most widely supported audio format around,
supported by all players on the market
(except a few Sonys)

• Files are small without a huge sacrifice in
audio quality

• Bookmarkable

• Older iPods can’t read
bookmarks: podcasts start
from the beginning rather
than the stopping place
from the last listen*

AAC • Same encoding settings produce smaller
files and better quality than MP3

• Bookmarkable

• Many devices cannot play
back AAC files

WAV • Nearly as widely supported as MP3 and
supported by the majority of current
players, including iPods

• Audio quality ranges from awful (smallest
files) to AIFF-level quality (huge files)

• Files not as small as MP3
• Files are not

bookmarkable

* Fourth-generation and later iPods, iPod minis, and iPod nanos support bookmarks in
MP3 files if the podcast is downloaded by iTunes 4.9 or later.

Encode Your Podcast Using iTunes
iTunes encodes audio files in MP3 and AAC formats quickly and
painlessly. To begin, import your master file into iTunes.

TIP If you have iTunes set to copy imported audio into its own library, the
next steps apply to the iTunes copy. But I recommend that you back
up your original just in case. (You can control iTunes copying behav-
ior in the iTunes Advanced preference pane, on the General tab.)

Once in iTunes, follow these steps to configure settings:

1. Choose iTunes > Preferences.

2. Click the Advanced icon and select the Importing tab.
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3. Choose MP3 Encoder from the Import Using pop-up menu.

4. Choose Custom from the Setting menu.

TIP iTunes lacks separate settings for encoding as MP3 and AAC and
general audio CD ripping. If you use iTunes to rip music, take note
of any settings in this area before changing them. You will want to
change back to your original configuration after encoding. If you
normally rip to MP3, changing AAC settings won’t a cause problem;
the reverse is true, too. You just change the encoder type back to
your preference in the Import Using pop-up menu.

5. Set options as described in Table 2 for MP3 or Table 3 for AAC.

Table 2: Recommended MP3 Encoding Settings

Item Setting Comments

Stereo Bit Rate 96 Kbps Results in a 48 Kbps rate for a mono file, which
we are creating; see Channels, below

Use Variable Bit
Rate Encoding

Checked Encoding rate changes based on audio complex-
ity; produces bigger files with the right tradeoff
of quality and size

Quality Medium High A good tradeoff between quality and file size

Sample Rate 22.050 kHz The lowest rate before the sound begins to
degrade

Channels Mono Fine for podcasts without much music; otherwise
select Stereo

Stereo Mode Normal The only option available for mono files and the
proper setting for stereo files as well

Smart Encoding
Adjustments

Checked Allows iTunes to adjust settings based on the
contents of your file

Filter
Frequencies
below 10 Hz

Checked Removes sounds that cannot be heard by the
human ear and reduces file size
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Table 3: Recommended AAC Encoding Settings

Item Setting Comments

Stereo Bit Rate 96 kbps As with MP3, results in a 48 kbps mono file

Sample Rate 44.100
kHz

The highest quality needed for a podcast; higher rates
don’t improve audio noticeably

Channels Mono Fine for podcasts without much music; otherwise
select Stereo

Use Variable Bit Rate
Encoding (VBR)

Checked Encoding rate changes based on audio complexity;
produces bigger files with the right tradeoff of quality
and size

Optimize for Voice Checked Useful for a podcast heavy on voice versus music

Now that you have made your settings, it’s time to encode and check
the file:

1. Select your newly imported master file and choose Advanced >
Convert to MP3 (the menu item will read Convert to AAC if you’ve
chosen AAC Encoder in the preferences).

iTunes creates a new copy of the audio file in the format you
picked and places that new file in the iTunes Music Library.

2. Listen to the new file in iTunes and verify that the audio meets
your goal.

3. With the file in iTunes, choose File > Show Sound File to locate the
actual file in the Finder.

4. Select the file in the Finder and choose File > Get Info to verify
that you have made it as small as you want it to be. (You can also
show the file’s size within iTunes. Choose Edit > View Options,
check Size, click OK, and scroll to the right to see the Size column.)

Your podcast file should now be properly encoded. Before you publish
it, though, you need to tag it, as I explain next.
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Tag Your Podcast
Add tags (bits of descriptive information, also known as metadata) to
your podcast file to help listeners know what your show is about and
where to file it in their libraries. Follow these steps to tag your file:

1. Select the track in iTunes and choose File > Get Info to bring up
the track info window.

2. In the Info pane, set up your tags (Figure 32). Table 4, next
page, has tagging suggestions for the most important tags, and the
rest are up to you. The more information you can provide, the
better.

FIGURE 32 Set up track
tags in the
Info pane.

Now that you have set the tags the way you want them, you are ready
to upload your podcast.
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Table 4: Suggested Tag Settings

Tag Recommended Content Example

Name The title of your podcast’s
episode. Generally this
should include a show
number and/or date and
a brief overview of the
content or guest.

Podcrumbs #4: Interview with Robert Burke
Warren Part 1

Artist Your name. Andy J. Williams Affleck

Album The title of your podcast.
This groups your podcasts
in iTunes or other
organizers. Include the
URL to your feed so
appears in the listing.

Podcrumbs –
http://www.podcrumbs.com/index.xml

Genre Podcast. Podcast

Comments Use the same show notes
that appear on the Web
site for your podcast.

Episode the Fourth in which I interview
singer/songwriter Robert Burke Warren
(www.robertbwarren.com) (Part 1 of 3 or 4)
about singing children’s music and analog vs.
digital recording, and he sings a cover of
Ghost Riders in the Sky with backing vocals
provided by the under-10 set. Details: MP3,
18:49, 6.5MB

Album Art A picture. While this is
optional, it helps to brand
your show.

Logo from the Podcrumbs Web site.

http://www.podcrumbs.com/audio/Podcrumbs_2005-01-03.mp3
http://www.podcrumbs.com/index.xml
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PUBLISH AND PROMOTE YOUR PODCAST

Now that your show is ready for the public, the next steps are to make
it available and let people know about it. You need to put the MP3 or
AAC file on a server, list the podcast on a Web site, reference the pod-
cast in the RSS feed for your Web site, and advertise the show. But
before I cover all that, you need to understand the potential pitfalls
of success.

Understand Bandwidth Costs
Moving bits costs money. The site or service that hosts your podcasts
pays money per megabyte, gigabyte, or terabyte per month, or by
their peak bits per second, for pushing data out from their network.
Most hosting companies pass that cost along to you in some way.
Before you upload your show and get it out there, you should be
aware of your hosting company’s policies toward bandwidth.

If your show were to become popular with lots of listeners wanting
to download episodes, you could find yourself on the losing end of
the great contradiction of the Internet: the more popular you are,
the more money it costs you.

As an example, when I wrote the article for TidBITS about
podcasting in February 2005 (http://db.tidbits.com/getbits.acgi?
tbart=07986), I created a companion episode of my podcast to go
along with it featuring an interview with Dave Winer
(http://www.podcrumbs.com/archives/2005/02/podcrumbs_8_int.
html). Before this point, each episode of my podcast was garnering
only a modest 300 downloads per episode. At about 10 megabytes
(MB) per episode, that was only around 3 gigabytes (GB) of traffic
moved from my Web site. My provider includes 30 GB per month
of bandwidth allowance as part of my recurring service fee. After
that, I pay $5 per gigabyte.

When the article was published, I moved over 25 GB in just a few
days. If the article had been any more popular, it would have cost me
a great deal of money. Instead of my usual $30 per month, I could
have been paying double, triple, or even more for that one month.

As another example, my editor, Glenn Fleishman, nearly ended up
paying $15,000 when tens of thousands of people downloaded a free

http://db.tidbits.com/getbits.acgi?tbart=07986
http://db.tidbits.com/getbits.acgi?tbart=07986
http://www.podcrumbs.com/archives/2005/02/podcrumbs_8_int.html
http://www.podcrumbs.com/archives/2005/02/podcrumbs_8_int.html
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PDF version of a book he co-wrote. He was just shy of a monthly
threshold, however, and owed nothing extra.

Many services simply cut you off when your bandwidth usage is
exceeded. Apple’s .Mac service used to offer a mixed message on
download limits, stating no clear policy. Recently, they established
a new set of rules that are quite clear: 10 GB per month with a regular
subscription (about $100 per year) and 25 GB per month with the
$50 per year extra storage upgrade that includes 2 GB of storage.

Some providers have much higher allowances than the typical hosting
company. One popular service is Libsyn (http://www.libsyn.com/),
which charges only by how much data you host with them—the rates
are modest. If your provider’s policies are restrictive, you should shop
around. There’s no reason you can’t host your site with your current
provider, but put the podcasts somewhere else.

Understand Syndication Formats
Syndication is used primarily by Web logs and news sites to allow
visitors to subscribe to changes or follow updates without revisiting
the site. Really Simple Syndication (RSS) and Atom are XML-based
(Extensible Markup Language) standards for syndicating Web site
content. The XML part defines a set of standard terms, and the
various versions of the RSS standard and the single, coalescing Atom
standard define how those terms are used.

RSS/Atom files typically list the most recent items posted to a Web
log and include the following information:

• The title of the entry (if available).

• The body of the entry or a short excerpt or abstract.

• The permanent URL of the entry, which is the URL to the specific
entry in the archives of the blog or on the site.

• The date and time it was posted.

• The URL of any enclosures attached to the entry. This entry points
to your podcast file.

• The name of the blog entry’s author.

http://www.libsyn.com/
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• The category of the entry (if any).

• More arcane information of interest mostly to automated software.

iTunes supports additional tags in syndication feeds, which cover
categorization in the iTunes Podcast directory, album art, whether the
content contains explicit language, and more.

Tools to Publish Podcasts
Use a Web log to make your shows available. Web logs lend
themselves nicely to podcasting by virtue of the fact that:

• Web logs are chronologically ordered sites in which the most
recent posting is at the top;

• Web logs tend to have RSS/Atom files associated with them; and

• Many Web log management systems can already handle
podcasting’s special needs.

You can use any of a number of Web log management tools:

• Radio Userland has podcast support fully integrated (and has had
it for years).
http://radio.userland.com/ ($39.94 annual subscription)

• Movable Type can be given this capability via the MT-Enclosures
extension by Brandon Fuller.
http://www.movabletype.org/ (free for non-commercial use)
http://brandon.fuller.name/archives/hacks/mtenclosures/ (free).

• WordPress provides built-in support for enclosures.
http://wordpress.org/ (free)

• Blogger and LiveJournal do not, as of yet, support Enclosures.
http://www.blogger.com/ (free)
http://www.livejournal.com/(free)

But, a workaround exists for these and other non-podcast-enabled
sites: Use Feedburner, which takes an existing RSS feed and mod-
ifies in a number of interesting ways, including converting it to
RSS 2.0 format and adding Enclosure links for any podcasts found
in an entry. Subscribers to your feed use a Feedburner URL you
provide rather than your host’s feed URL.
http://www.feedburner.com/ (free)

http://radio.userland.com
http://www.movabletype.org/
http://brandon.fuller.name/archives/hacks/mtenclosures/
http://wordpress.org/
http://www.blogger.com
http://www.livejournal.com/
http://www.feedburner.com/
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You can post podcasts to your Web log through a Web interface, but
you might prefer to use a program that simplifies posting entries and
uploading files. The two I like are:

• MarsEdit: From Ranchero Software, MarsEdit has an HTML
view only for editing entries. The recent sale of Ranchero’s
NetNewsWire product has left MarsEdit’s future a little unclear.
http://ranchero.com/marsedit/ ($24.95)

• Ecto From Kung Foo TV, Ecto supports HTML and WYSYWIG
editing of blog posts.
http://ecto.kung-foo.tv/ ($17.95)

If you choose not to use a Web log to manage your podcast files, you
can use one of these programs to generate the necessary RSS/Atom
feeds and upload the individual episodes:

• Feeder: From Reinvented Software.
http://www.reinventedsoftware.com/feeder/index.html ($29.95)

• Podcast Maker: This package from Potion Factory also supports
the creation of chapters in podcasts, a feature supported by iTunes
to allow access to specific sections of a specific episode.
http://www.potionfactory.com/ ($30)

Upload and Publish an Episode
The procedure for uploading and posting an episode of your show is:

1. Upload the file to your site using either the Web interface to your
Web log or one of the Web log management tools described just
previously.

2. Create a new Web log entry that includes the same show notes you
put in the Comments field in iTunes. Make sure to link to the pod-
cast file in the entry (in the tip just ahead “Episode the Fourth”
links to the MP3 file).

http://ranchero.com/marsedit/
http://ecto.kung-foo.tv/
http://www.reinventedsoftware.com/feeder/index.html
http://www.potionfactory.com/
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TIP Show notes provide an episode synopsis, and they include the size
of the file and the duration of the podcast. For example:

Episode the Fourth, in which I interview singer/songwriter Robert
Burke Warren (http://www.robertbwarren.com/) (Part 1 of 4)
about singing children’s music and analog vs. digital recording.
He sings a cover of Ghost Riders in the Sky with backing vocals
provided by the under-10 set. Details: mp3, 18:49, 6.5 MB.

3. Most Web log packages handle the generation of the RSS entry
and, upon seeing the link to the MP3 file, add the required
enclosure tag to your feed. If not, you may have to create these
entries manually, a task that is beyond the scope of this ebook.

After this, it’s up to you to tell the world about your episode.

Promote Your Podcast
When you first establish your podcast, you should get it listed in the
major podcast directories. These are:

• Apple iTunes Music Store: The iTunes Music Store has an
excellent podcast directory, which you access through iTunes. In
the Podcasting section of the store (accessed via the Podcasts link
on the left side of the store home page), is a link (again, on the left)
labeled “Submit a Podcast,” which provides a form for you to fill
out. When you add your podcast to its directory, it automatically
checks your RSS/Atom feed regularly and adds new episodes to its
listings as they become available. In this way, you need tell iTunes
about your podcasts only once. The listings stay current as long as
your RSS/Atom feed is updated whenever you post new podcasts.

• IPodder.organization: This is the original podcast directory,
and it is still actively maintained (http://www.ipodder.org/). Sub-
mitting your podcast to it is a bit cumbersome: you must navigate
through the directory to each category page where your show
should be listed, scroll to the bottom, and select “Submit a Link.”

• Yahoo: Yahoo’s Podcasting directory is a new kid on the block,
but it is probably the easiest to add your show to. Just navigate to
http://podcasts.yahoo.com/publish and add your feed to the form
on the right labeled “Already have a Podcast?”

http://www.podcrumbs.com/audio/Podcrumbs_2005-01-03.mp3
http://www.robertbwarren.com/
http://podcasts.yahoo.com/publish
http://www.ipodder.org/
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• Podcast Alley: Podcast Alley is another well-respected directory
that’s been around for a long time. Add your show by navigating to
http://www.podcastalley.com/add_a_podcast.php and filling out
the form.

There are many other directories out there; if any aim at an audience
similar to yours, make sure you submit your listing.

After publishing each episode and ensuring that your RSS feed has
been updated, you should also promote your podcast in other ways:

• Update audio.weblogs.com: audio.weblogs.com is a free
service that you can use to alert the world to new podcast postings.
Your blogging system may ping (or alert) this service when you
post your podcast to your Web log; check your Web log settings
to see if you can add a new site to ping if it’s not already there.
Otherwise, you can manually ping this site using the Web form
at http://audio.weblogs.com/pingSiteForm.

• Post a promo clip to OpenPodcast.org: OpenPodcast.org
(http://openpodcast.org) is a free service that lets you submit full
podcasts or short promo clips via email. (I tend to favor small
promo clips rather than sending full podcasts due to my service
provider’s maximum email message restriction.) You can also call
a phone number to record a short clip. These clips are then listed
in the OpenPodcast.org RSS 2.0 feed and audio.weblogs.com is
pinged as well. Many people monitor this feed to look for
interesting promos and find new podcasts.

• Provide a promo clip to other podcasters: Many podcasters
are happy to play promo clips from other podcasters looking to
advertise their shows. The etiquette for doing this varies by pod-
caster. Your best bet is to simply listen to other podcasts to learn
what they will and will not play and how you may submit your clip
to them.

http://www.podcastalley.com/add_a_podcast.php
http://audio.weblogs.com/pingSiteForm
http://openpodcast.org
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RESOURCES

In the year since podcasting exploded onto the scene, I have found
these resources invaluable:

• Phillip Torrone at Engadget wrote one of the first comprehensive
articles on how to podcast, which has been invaluable (as have the
comments following the article).
http://www.engadget.com/entry/5843952395227141/

• Hugo Schotman provided a four-part, must-read, detailed descrip-
tion of his podcasting techniques and he even diagrams his setup
(he uses GarageBand).
http://log.hugoschotman.com/hugo/2004/09/audio_blog_

soft_1.html

• My editor, Glenn Fleishman, wrote a fantastic article on using Audio
Hijack Pro to record multiple sound sources without lag issues.
http://www.macdevcenter.com/pub/a/mac/2005/01/25/podcast.
html

I later modified some of his article to handle adding other audio
sources for a post in my Web log.
http://www.podcrumbs.com/archives/2005/01/macdevcentercom.
html

In October 2005, Glenn updated the article to include details for
updated versions of Audio Hijack Pro and Skype.
http://www.macdevcenter.com/pub/a/mac/2005/10/10/how-to-
podcast.html

• Teach for Two has a nice description of the basic process.
http://www.teach42.com/2005/01/06/podcasting-its-easier-than-
you-think/

• Currently, Wikipedia has a good entry about podcasting.
http://en.wikipedia.org/wiki/Podcast

• Michael Geoghegan has an article on his Web site that describes
how he uses Audacity as well as a nice external microphone.
http://mwgblog.com/archives/2004/12/27/podcast-about-the-
podcast/

http://www.engadget.com/entry/5843952395227141/
http://log.hugoschotman.com/hugo/2004/09/audio_blog_soft_1.html
http://log.hugoschotman.com/hugo/2004/09/audio_blog_soft_1.html
http://www.macdevcenter.com/pub/a/mac/2005/01/25/podcast.html?CMP=ILC-macrss&ATT=How+to+Record+a+Podcast
http://www.macdevcenter.com/pub/a/mac/2005/01/25/podcast.html?CMP=ILC-macrss&ATT=How+to+Record+a+Podcast
http://www.podcrumbs.com/archives/2005/01/macdevcentercom.html
http://www.podcrumbs.com/archives/2005/01/macdevcentercom.html
http://www.teach42.com/2005/01/06/podcasting-its-easier-than-you-think/
http://www.teach42.com/2005/01/06/podcasting-its-easier-than-you-think/
http://en.wikipedia.org/wiki/Podcast
http://mwgblog.com/archives/2004/12/27/podcast-about-the-podcast/
http://mwgblog.com/archives/2004/12/27/podcast-about-the-podcast/
http://www.macdevcenter.com/pub/a/mac/2005/10/10/how-to-podcast.html
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• Garth Kidd wrote the Busy Podcaster’s Guide, which explains some
advanced topics such as using BitTorrent and feed tweaking.
http://ipodder.sourceforge.net/docs/bpg.html

• The Podcasters group at Yahoo Groups is a great community of
podcast enthusiasts. A lot of very friendly and helpful people hang
out on the mailing list. Search the archives before posting your
questions to make sure you aren’t re-treading old ground.
http://groups.yahoo.com/group/podcasters/

http://ipodder.sourceforge.net/docs/bpg.html
http://groups.yahoo.com/group/podcasters/
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In contrast to traditional print books, Take Control ebooks offer
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the publisher.
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